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How do I use the CASE Benchmarking Toolkit (“CBT”)?

- a click-by-click guide for the busy advancement professional

This document answers the following questions CASE members may have about using and navigating the CASE online Benchmarking Toolkit
(frequently referred to as the “CBT” or, simply, the “Toolkit”):

A. HOW DO I GAIN ACCESS TO THE CASE BENCHMARKING TOOLKIT (CBT)? Page 2
B. HOW DO I RESPOND TO A SURVEY AND ENTER MY INSTITUTION’S DATA? Page 4
C. HOWDO IDISPLAY SURVEY RESULTS ON MY SCREEN? Page 12
D. HOW DO I DOWNLOAD THE RESULTS GRAPHIC INTO MY OWN MSWORD REPORT (AND PRETEND IT’S MINE)? Page 20
E. HOW DO IDOWNLOAD NUMERIC DATA INTO AN EXCEL SPREADSHEET FOR MY OWN FURTHER ANALYSIS? Page 21
F. ISTHERE A SHORT WALK THROUGH / SUMMARY FOR RUNNING OR ACCESSING YOUR RESULTS IN THE CBT? Page 23

If this is your first time accessing the system, start with question “A” on the next page. If you have already accessed the system and are somewhat
familiar with it, you may wish to skip to question “C” on page 12. If your question is not in the above list, please contact CASE Research at
research@case.org for further assistance.
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A. How do I gain access to the CASE Benchmarking Toolkit (CBT)?

1. Your educational institution must be a CASE member, as an individual must be a general or professional member of CASE.

2. You must be designated by the leader of your community of practice or by CASE to be a user of the CBT.

Welcome to E M mcm:ng !H’ " ugm.

3. In the URL address space, type: http://benchmarking.case.org. This takes
you to the “front door” of the CBT, shown here.

E-mail Address =

Password =

4. To login, please enter your email address and CASE password. If you have
. . . . Access to the CASE Benchmarking Toolkit is reserved for Forgot Password
misplaced your CASE password you can retrieve it online at: CASE members only.
. . . Wisit the CASE website for membership information.
http://iweb.case.org/iweb/LogIn/RetrievePassword.aspx
or via the Login Help on the CASE homepage.

About Benchmarking Terms of Use Help

Benchmarking is a process that allows members of a community of practice (a group of peer institutions) to compare data
about their programs ameng themselves. Communities of practice define the data or information they want compare and
design surveys to collect it. Survey responses are gathered through the CASE Benchmarking Toolkit, which allows each
member of the community to break down and display the results according to his or her interests and needs.

Please read the following if this is your first visit to the toolkit:
*  What is "benchmarking'!
* How do | gain access to the CASE Benchmarking Toolkit!"

* How do | start or join a community of practice!
* How do | use my benchmarking results for continuous improvement within my organization!

Developad by CounterMarch Systems
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5. If you have successfully gained entry to the

. L7, ” .
CBT you will see this “Welcome” screen: Welcome to the CASE Benchmarking Toolkit!

& va =

Read more about benchmarking Enter some data into an existing survey Get reports and charts from past surveys

3E  We're available to help at any time by emailing research@case.org.

6. From this point on, whenever you want to move around inside the CBT,

it is important NOT to click on your browser’s back button. Instead, Toolkit - Windows Internet Explorer
click on the CBT’s own internal buttons and tabs. _

'l\‘-’:_hjf - IE, http://benchmarking.case.org/

J File Edit View Favorites Tools Help

¢ Favorites @ CASE Benchmarking Toolkit

BENCHMARKING TOOLKIT B my s

Welcome to the CASE Benchmarking
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B. How do I respond to a survey and enter my institution’s data?

1. Please click on “Enter some data iqto an existing survey” or “My Surveys”

\ BENCHMARKING TOOLKIT B 'Y SURVEYS s REPORTS ® HELP B LOGOUT

Welcome to the CASE Benchmarking Toolkit!

Read more about benchmarking Enter some data into an existing survey Get reports and charts from past surveys

<F We're available to help at any time by emailing research@case.org.
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2. The next page lists all the available surveys, each in its own separate blue box. (The example shown has one survey available).

| BENCHMARKING TOOLKIT M MY SURVEYS  gl; REPORTS @ HELP &

Open Surveys
Michigan State University Click on a survey to enter your school's data.

Once you have completed and submitted the survey, you will have the ability to view reports containing data from oth
schools.

Can't find a survey you think you should see? This could be because you're not assigned to the proper discipline.

CASE can assist you with this. Please contact research@case.org.

Each survey can be accessed by clicking on the blue box. The yellow arrow in the lower right hand corner indicates what percentage of
the questions you have already answered for that survey. In the example shown, we have almost completed the survey, it presently
shows “78%”. If you were only half complete it would indicate “50%”" .

If you do not see your survey listed it is most likely because you have not yet been designated to take the survey.
Please contact research@case.org if you are the designated respondent for your institution and do not see your survey.

Please select the blue box with the title of your survey to continue to step three.


mailto:research@case.org
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3. Clicking anywhere on the blue box takes you into the survey. You will notice the title of the survey at the head of the page, a short description of
it, and then section headings (A, B, C).

BENCHMARKING TOOLKIT B MY SURVEYS fls REPORTS ® HELP

p

LOGOUT

Available Surveys > CASE's Basic Benchmarking Survey - DEMO ONLY

= CASE's Basic Benchmarking Survey - DEMO ONLY

E About this survey = About surveys

This basic survey can be taken by any post-secondary or higher eduction organization. Data you enter will automatically generate some simple key ratios that your organization can use for benchmarking its fundraising and staffing levels
with those of peer institutions. It should take you no more than 20 minutes to complete, once you have gathered the basic data. Some tips to help you complete the survey mare easily: (1) Gather your organization's data on number of
staff and total expenditures before going through the survey. (2) For the expenditure questions, enter the whale dollar amaount anly, i.e. without the dollar symbaol, commas, decimal point, and cents. Far large numbers, make sure you

enter the correct number of zeros. (3) For those organizations entering from outside the USA and not using dallars, convert your own currency to dallars using the information available at: http://www.xecom/. (4) CASE Research staff are
atyour elbow to help: call Jackson at 202/478-5661 or contact research@case.org.

Would you like to review or export the survey? View Survey | | Download Survey

A. First, let's gather some basic descriptive information about your organization...

100.0%
B. Next, let's hear about the voluntary support your organization raises... 100.0%
C. Finally, let's hear about your advancement operation's staffing levels and expenditures... 66.6%

4. Before you select a section to begin you may want to download the survey for internal dissemination to aid in the collection of requested data.

To download the survey, please click the “Download Survey” button. This will download an xml file of the full survey (to be opened in Excel as
an .xIs file). Alternately, you may make a cursory review of the survey by clicking the “View Survey” button.

5. To begin answering questions please click on the first (or pertinent) section. The percentage of completed answers for that section is displayed

on the far right of the row. In the example above I would click section C, as it is only 66 percent complete. The other sections have been
completed and stand at 100%.

Let’s click on section C...
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6. The survey may include definitions and clarifications at the head of the section.

ternet Explorer
I& http://benchmarking.case.org/

o
=1 = |

J File Edit View Favorites Tools Help

s Favorites @ CASE Benchmarking Toolkit

¥

|\ BENCHMARKING TOOLKIT B MY SURVEYS fla REPORTS ® HELP

i— Available Surveys > CASE's Basic Benchmarking Survey - DEMO ONLY (FY 2009) = Finally, let's hear about your advancemen

= C. Finally, let's hear about your advancement operation's staffing levels and expenditt

In this section we will be asking about staffing levels and expenditures for your advancement operations.

Please report your staff numbers in paid "full-time equivalent” employees (FTEs) to two decimal places. For example, if you have two full-time employee
would enter {2x1.00)+(3x0.50), or 4.50. If you have 50 paid conference center staff who are employees of your institution and who are working one day a1

Include all staff who are paid and who work for, or who are under the direction of, the advancement office, even if they are legal employees of anothero
external contractors or consultants. Do NOT include the time spent on advancement activities by your organization's senior-most non-advancement exe

There are separate questions for the different advancement disciplines and for front-line/support staff. The disciplines are "alumni relations," "developn
"advancement management". If you are a "one-person shop" wearing multiple hats and warking 300% time, then CASE understands and feels for you, b
and spread the fractions of yourself appropriately across the different disciplines according to how your time is distributed. By "front-line staff" we mean
funding sources. By "support staff' we mean everyone else.

When you get through this section, you're DONE! Ready? Ok, let's go!

1. How many paid full-time-equivalent "front-line" staffda  [45 [l
you have who waork on alumni relations/alumni affairs?

This question does not apply to me

2. How many paid fuII—time—equi\.falentl"support" sltaffdlcl 10 [
you have whowark on alumni relations/alumni affairs?

3. How many paid full-time-equivalent "front-line" staffda |55 ]
you have who work on fundraising/development?
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7. Questions types include text/numeric, multiple choice dropdowns, and question matrices. Please click on dropdown boxes to display all
available choices. The toolkit requires a response for each question. If a question does not apply to you, please check the not applicable box
(“This question does not apply to me”).

8. Use the open ended text box located at the bottom of the page to give, if necessary, some very brief additional information that you think would
be useful for the survey participants to know, such as why your number may be unusual, or that your staffing includes a large number of full-
time employees for only a one month period, for example.

9. Remember to click on the green “Save Responses” button at the end of each section to save your responses. Once you save your responses you
can leave and come back to the toolkit. (“Save” is not the same as “Submit”, which we will review later).

B MY SURVEYS = REPORTS ® HELP

E 13.  Whatwas your organization's total actual budget
expenditures this year, or in its most recently
completed accounting year, for all communications and

g marketing?

350,000 L

14.  Whatwas your organization's total actual budget
expenditures this year, or in its most recently
completed accounting year, for all advancement
services?

250,000 L

15. Whatwas your organization's total actual budget 150,000 [l
expenditures this year, or in its most recently
completed accounting year, for all advancemeant
management?

Ifthere's any other information you'd like to include, please do so below!

Cancel Changes Save Responses
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10. When you have completed and saved all the questions in all sections, you can preview and submit your data.

The survey screen now shows that 100% of the survey questions have been answered, and displays an additional green “Preview and Submit

Survey” arrow.
BENCHMARKING TOOLKIT M MY SURVEYS  fl. REPORTS  ® HELP

-~

B LOoGOUT

Available Surveys > CASE's Basic Benchmarking Survey - DEMO ONLY

= CASE's Basic Benchmarking Survey - DEMO ONLY
About this survey _ About surveys _

This basic survey can be taken by any post-secondary ar higher eduction organization. Data you enter will automatically generate some simple key ratios that your organization can use for benchmarking its fundraising and staffing levels
with those of peer institutions. It should take you no mare than 20 minutes to complete, once you have gathered the basic data. Some tips to help you complete the survey more easily: (1) Gather your organization's data on number of
staff and total expenditures before going thraugh the survey. (2) For the expenditure questions, enter the whaole dollar amount only, i.e. without the dollar symbol, commas, decimal point, and cents. For large numbers, make sure you

enter the carrect number of zeros. (3) For those organizations entering from outside the USA and not using daollars, convert your own currency to dollars using the information available at: http:/fwww.xe.com/. (4) CASE Research staff are
atyour elbow to help: call Jackson at 202/478-5661 or contact research@case.org.

Would you like to review or export the survey? View Survey | | Download Survey

A. First, let's gather some basic descriptive information about your organization... |

100.0% |
B. Next, let's hear about the voluntary support your organization raises... | 100.0% |
C. Finally, let's hear about your advancement operation's staffing levels and expenditures... |

Click on that green arrow to submit your data. You will then be given the chance to preview and download your responses before submitting;
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BENCHMARKING TOOLKIT ' MY SURVEYS o= REPORTS ® HELP 'Eg LOGOUT

— Available Surveys > CASE's Basic Benchmarking Survey - DEMO ONLY

CASE's Basic Benchmarking Survey - DEMO ONLY

You are now ready to preview your responses, make any corrections and submit your survey.

E Submitting your survey means your data enter the survey database along with all other institutions' responses and are no longer available for modification. Please preview your responses before submitting. To do this, dlick an the "Preview
Data" button below to review your responses and check for typos. If you find an error, click out of the box and then click on the "Not Quite Yet" button to return to the main survey screen and go back to the section and question you want to

edit. Remember to click on the green "Save Responses” button again at the bottom of that screen to save the final change.

You should also save a copy of your responses in Excel for future reference before submitting by clicking on the "Download Your Survey” button below. Only when you are sure you are done editing and downloading should you click on the
green "Submit My Data" button below to complete the process. After that is done you will have access to results through the "Reparts” tab above.

Ifyou'd like ta make changes to your data, please click here.

Waould you like to download a copy of your current responses?

| Download Your Survey |

| Preview Data | | Mot Quite Yet | Submit My Data

11. Please review your data using the “Preview Data” button. You can see the questions and examine your responses for errors and typos.

1. First, let's gather some basic descriptive information about your organization...

Far what type of organization will you be reporting data in your answers to these questions? A complete individ gal campus,
college, or universify

If your organization is a sub-unit or affiliate of a larger educational institution, what kind of organization is it? Mot a sub-unit of a larger L
organization s

Is your institution “public” (i.e. taxpayer-funded), or “private"? "Public” of

PP T I " A v L . o [ o - s

10
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Please pay particular attention to the number of zeros you have typed in for large numbers. Do you have 10,000 alumni, or 100,000?

12. If all your responses were fine, please click the “x” in the top right corner of the preview pane to close it, and hit the green submit button. If
instead you spotted entries you want to change or correct, click the “Not Quite Yet” button to return to your survey. To make the changes,
simply go to the question as before and manually change the present response to your new response. IT IS IMPORTANT TO CATCH ALL THE
ERRORS AND TYPOS AT THIS STAGE, BECAUSE ONCE YOU “SUBMIT” YOUR DATA AT THE NEXT STEP, YOU WILL NOT BE ABLE
TO MAKE ANY MORE CHANGES.

13. When you are satisfied with ALL your responses, click out of the preview pane via the “x” again, and click on the green “Submit Data” button.
Once you have done this you will be returned to the “Available Surveys” page, but this time the survey you have just completed will not

appear.

Congratulations, your responses are now part of the accumulated data in the CASE Benchmarking Toolkit.

11
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C. How do I display survey results on my screen?

1. Login to the Benchmarking Toolkit as explained above

BENCHMARKING TOQLKIT B MY SURVEYS s REPORTS ® HELP B LOGOUT

Welcome to the CASE Benchmarking Toolkit,

Read more about benchmfarking Enter some data into an existing survey Get reports and charts from past surveys

Vol

<E We're available to help at any time by emailing research@case.org.

2. Click on the “Reports” tab in the top menu bar, or alternatively, click on the Reports button

12
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3. To benchmark your data against other institutions please choose “Raw Data Report.”

' BENCHMARKING TOOLKIT F My SURVEYS s REPORTS @® HELP & LOGOoUuT

Reports

@ Raw Data Report

The Raw Data Report offers a look at the actual responses offered by multiple institutions over 1 period of time or 1 institution over multiple periods of time. No fancy charts, no colorful graphs ... just data. If you like spreadsheets (or
carry a calculator in your shirt pocket) this repaort is for you.

{“{‘3 Dashboards

Dashboards take the underlying data from the Raw Data Report and provide an easy visual interpretation of the supplied data.

4. To benchmark your data against other institutions please select “Multiple Institution Report.” “Multiple Year Report” is only for repeat
participants who wish to compare their own institution’s data by year. “Multiple Year Report” is for one institution over multiple years,
where as “Multiple Institution Report” is for comparing multiple institutions in the same year.

n

\ BENCHMARKING TOOLKIT B MY SURVEYS i's REPORTS @® HELP

@ LOGOUT

C— Report Type > Raw Data Report Type
Available Raw Data Reports

What type of raw data report are you interested in running?

@ Multiple Institution Report

The Multiple Institution Report allows you the ability to look at your data as well as the summary statistics for a group of institutions (defined specifically or by generic criteria). Please note that the summary statistics will anly be displayed
if at least 5 institutions are available to include.

Multiple Year Report

The Multiple Year Report contains your institution's data for ane survey over a number of years.

13
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5. Pick which available survey you want to see the results for by clicking on it (your list of survey names may be different to the ones shown
here). For this example we'll select the “CASE’s Basic Benchmarking Survey” to be displayed. Notice under Survey Status that this survey
has been submitted.

\ BENCHMARKING TOOLKIT E MY SURVEYS s REPORTS ® HELP B LOGOUT

e— Beport Type > Raw Data Report Type > Reportable Surveys

Reportable Surveys

Please click on a survey.

Survey Name Term Discipline Survey Status Survey Type

1994 Group of Development Directors Benchmarking Survey FY 2010 Development & Fundraising incomplete Community of Practice
CASE Advancement Investment Metrics Survey FY 2010 Development & Fundraising incomplete Community of Practice
Fundraising in International Schools: 2010 CASE Benchmarking Survey FY 2010 Development & Fundraising incomplete Community of Practice
CASE Benchmarking Survey for International Schools FY 2009 Development & Fundraising incomplete Community of Practice
CASE's Basic Benchmarking Survey - DEMO ONLY FY 2009 Development & Fundraising submitted Community of Practice
CASE AIMS (the "Pilot" Advancement Investment Measurement Survey) FY 2008 Development & Fundraising incomplete Community of Practice
Survey of Fundraising Staff FY 2008 Development & Fundraising incomplete Community of Practice
Survey of Big-10 Development IT Offices FY 2007 Development & Fundraising submitted Community of Practice

Next you will see some “Filter Options” and “Report Criteria”. The CBT allows you to “filter” (i.e. select) by 9 different options for types of
institution:

— BeportType = Raw DataReport Type > Reportable Surveys

Reportable Surveys

Filter Options Report Criteria

< Activity Group Using the available criteria on the left, please select which subset of schools you'd like to include in the report. Please note that you can include schools from

ar you can include institutions specifically, which allows you to create reports using the District 2 institutions, along with the University of Texas.
< Carnegie Classification

© CASE District

Cancel Report Get Report Download Report
o Educational and General Budget
< Enrollment :

' Institutional Group
O Public / Private
O US Region

O US State

= By Name Specifically

14



How do I use the CASE Benchmarking Toolkit (“CBT”)?

Moving the cursor over the name of a filter option causes it to become highlighted in blue. Clicking on the small circle next to a filter option opens
up the following respective choices of sub-group within it:

“Carnegie Classification”:

“CASE District”:

“Educational and General Budget”:

“Enrollment”:

“Institutional Group”:
“Public/Private”:
“Region”:

“State”:

“By Name Specifically”:

33 different classes of institution.

includes Districts I through VIII, CASE Europe (which includes the UK, Ireland, the rest of Europe,
Middle East, and Africa) and CASE Asia-Pacific.

four quartile ranges of total institutional budget size (using the 2006 data distribution for US
institutions in IPEDS).

four quartile ranges of FTE students at start of fall semester (using the 2006 data distribution for US
institutions in IPEDS).

groupings of institutions by survey or community of practice.
whether an institution is primarily government-funded or privately funded.
the nine official US Bureau of the Census Regions, plus “US Service Schools”.

all States of the USA, plus the District of Columbia, American Samoa, the Commonwealth of Puerto
Rico, the Federated States of Micronesia, Guam, the Marshall Islands, Northern Marianas, and Palau.

Allows you to hand pick your group by institution name. Must select at least 5 other institutions.

When you click on the circle button for one of the filter options in the list, the respective sub-groups listed above for that option will appear on
the right. You can then make either one selection or multiple selections of sub-groups of institutions from a single filter option to put into your
chosen results mix, or you can combine selections from multiple filter options.

Be sure to save your criteria each time you add to it.

15
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e To select institutions using one filter option, such as “Public/Private”, click on “Public” to select only public institutions that have
responded to this survey.

e To select institutions using multiple selections of sub-groups within one filter option, such as on “CASE District”, click the circle next to
“CASE District” and then select, for example, three CASE districts by holding the “CTRL” button down on your keyboard and left-
clicking on “District 2”7, “District 4” and “District 8”. This means only institutions from any of those three CASE Districts that have
responded to this survey will be included in your chosen results display.

o To select from several different filter options, click on, for example, the filter option “Carnegie” and select “Doctoral/Research
universities”, plus click on “Region” and select “Great Lakes”, plus click on “Public/Private” and select “Private”. The institutions that
will now be included in your report display are any that completed this survey and fulfill at least one of these filter conditions.

6. When you have made all the selections you want, save your changes at the bottom of the screen. This will take you back to the “Reportable
Surveys” page, where you will now see listed in the “Report Criteria” box all the selections you haye made.

N

Report Type > Raw DataReport Type > Reportable Surveys

Reportable Surveys

Filter Options Report Criteria

Activity Group Using the available criteria on the left, please select which subset of s#hools you'd like to include in the report. Please note that you can include schools from their cha
or you can include institutions specifically, which allows you reate reports using the District 2 institutions, along with the University of Texas.
Carnegie Classification
Please include all schools whaose..
CASE District
- Carnegie classificiation: Doctoral /Resear
Educational and General Budget . .
- Institutional Type: Public

Enrallment - (CASE District: CASE District 1

Institutional Group

Public / Private Cancel Report Get Report | Download Report |
LS Region
U5 State

By Name Specifically

16
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If your Community of Practice (survey group) is located outside of the U.S., you will want to create your selected group “By Name
Specifically.” This is will allow you to hand pick the group you wish to benchmark yourself against. After you click on “By Name
Specifically” you will be taken to this dialog box:

BENCHMARKING TOOLKIT U MY SURVEYS o= REPORTS @ HELP & LOGOUT

I Reportable Surveys F
Fiter Options T — ]
Activity G
ctivity Group Please drag and drop all institutions you'd like to include over to the right-hand-column ...
C ie Classificati
Armegie Classiication Select multiple institutions at once using the Ctrl or Shift keys!
CASE District
e Available Institutions Selected Institutions
Educational and General Budget
Evoliment Council for Advancement and Support of Education = Drexel University
nrallmen
o East Tennessee State University Columbia University
Institutional Group
] . . S
public / Private Johns Hopkins University Boston College )
Lehigh Universi Arizona State Universi -
Us Region 9 ty >> y
US State Massachusetts Institute of Technology = American University
North Carolina State University
By N Specificall
yhame speciica ™y Rice University =<
Stanford University <
The Ohio State University [
University of Pennsylvania -
p—
Cancel Changes Save Changes

To select your group please highlight 5 or more institutions in the left box (which houses all submitted respondents) and hit the single “>"
button to move them over to the right box. This will be your selected group. In this example, we have selected Drexel, Columbia, Boston,
Arizona State, and American University as our selected group. Once you have created your selected group hit save.

IMPORTANT NOTE: You MUST select at LEAST 5 other institutions to run or download a report. If your report fails to generate it is most likely
because there are not 5 institutions (in addition to your own) which meet your selected criteria. You MUST have 5 institutions which meet the
criteria (or were chosen by name specifically) to run reports in the CBT to preserve anonymity.

17
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7. Click on “Get Report” and you should see the screen below. All the questions in the survey are listed down the left, and all the institutions in
your selected group are listed across the top. Their answers to the survey questions are shown in the columns. The first column contains your
institution’s responses, and its name is shown at the top. The other column headings are shown as “anonymous” to prevent identification of
other respondents in your selected group.

BENCHMARKING TOOLKIT

B MY SURVEYS

ils REPORTS

® HELP

Report Type > Raw DataReport Type >

Reportable Surveys > Raw Data Report

CASE's Basic Benchmarking Survey - DEMO ONLY - FY 2009

First, let's gather some basic descriptive information about...

For what type of organization will you be reporting data in your

answers to these questions?

If your organization is a sub-unit or affiliate of a larger
educational institution, what kind of organization is it?

Is your institution “public” (i.e. taxpayer-funded), or "private"?

What was the total budget (expenditure) of your organization in

its most recently completed accounting year?

Next, let's hear about the voluntary support your organizat...

How much "total voluntary support” did your organization raise
this year, or in your most recently completed accounting year?

If your organization is currently in an educational fundraising
"campaign,” what is that campaign'’s final total fundraising goal?

If your organization is currently in an educational fundraising
campaign, what is the planned length of that campaign (in
maonths) until completion, including all its phases (advance and

public) ?

If your arganization is currently in an educational fundraising
camnainn. what was the total value of all aifts to that camnainon

Michigan State U

A complete
individual
campus, college,
or university

Mot a sub-unit of
alarger
organization

"Public”
595,000,000

Anonymous 1

A complete
individual
campus, college,
or university

Mot a sub-unit of
alarger
organization

"Private"

100,000,000

Michigan State Uil Anonymous 1

200,000,000

400,000,000

47

100,000,000

0

1,000,000,000

60

10,000,000

Anonymous 2

A complete
individual
campus, college,
or university

Mot a sub-unit of
alarger
organization

"Public"

Anonymous 2
23,500,000

200,000,000

48

63,500,000

Anonymous 3

A complete
individual
campus, college,
or university

Mot a sub-unit of
alarger
organization

"Private"

200,000,000

Anonymous 3
120,000,000

300,000,000

72

25,000,000

Anonymous 4

A complete
individual
campus, college,
or university

Mot a sub-unit of
alarger
organization

"Private"

3,000,000,000

Anonymous 4
600,000,000

4,200,000,000

48

650,000,000

Anonymous 5

A complete
individual
campus, college,
or university

Mot a sub-unit of
alarger
organization

"Private”

250,000,000

Anonymous 5
75,980,000

50,000,000

60

12,000,000

EE

E

8. To view a graphical display of numeric and multiple choice questions, please click the bar chart symbol on the left hand side of the page.
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9. You should now see a multi-column bar chart similar to the one below. A list of the chosen filter criteria is listed at the top of the chart. Below
that is your institution’s response (in this example 10). Below your response is the median and aggregate mean for both your selected group and
the whole group. The N count represents the number of respondents you are comparing yourself to (in this case,  have selected 5 institutions by
name specifically). You now have two benchmarks against which you can compare your own institution’s value: (i) your chosen peer group (i.e.
Selected Group), and (ii) the universe of institutions (all submitted respondents).

Selected Group matches the following filters:

-Institution Mame: Drexel University, Columbia University, Boston College, Arizona State University, American University

=

How many paid full-time-equivalent "support” staff do you have who work on alumni relations/alumni affairs? (FY 2009)

Source: CASE Benchmarking Toolkit
Michigan State University 12

Response: 10.00

E’ 10
Group Median Mean n % 5
Selected Group 5.00 13.80 5 E
All Institutions 5.00 11.83 15 [

[T I - ]

Selected Group All Institutions

*Your response is included in all aggregates [ Average Response

* N/A responses are excluded from all aggregates

So this chart tells me that the responding institution:
Has reported 10 support staff who work on AR/AA in FY 2009
The median of the Select Group (chosen by name specifically) is 5, and just also happens to be the same for All Institutions (15 in total)

The mean is 13.8 for the select group and 11.83 for all institutions
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D. How do I download the results graphic into my own MSWord report (and pretend it’s mine)?

1. Click on the diskette symbol at top right of the multi-column bar chart screen graphic. When prompted, select a destination folder in your
directory in which to save your graphic (and remember where you put it!).

2. Open up the Word file with your text report and position your cursor roughly where you want the graphic to appear. It's a good idea to press
“Enter” several times to make a space for the graphic, so you can see ahead of time the shifting of surrounding text that might occur).

3. If you are working in XP with Word version 2003, click on “Insert” in the top menu, and then in the drop-down sub-menu click on “Picture”
and “From file”. This generates a folder and file map for you to select from. Click on the name of the file you just saved with your chart in to
import it into Word. It should then appear in your Word file where you left your cursor.

4. If you are working in the Office 2007 version of Word, click on “Insert” in the top menu, and then in the ribbon menu click on “Picture”. This
generates a folder and file map for you to select from. Click on the name of the file you just saved with your chart in to import it into Word. It
should then appear in your Word file where you left your cursor.

5. To fine-control the position of the graphic further on the page, click on the center of the graphic to make it active. Then click on “Format” in the
top menu, and then in the drop-down sub-menu click on “Object” and “Picture” and then on the “Layout” tab. This should bring you into a
dialog box with five “doggie” pictures. Click on “Square” to set the rule for positioning text around the picture, and then on one of the “Left”,
“Center” and “Right” buttons, according to where you want the graphic to sit horizontally. The text should “wrap” around the sides of the
graphic automatically.

6. You can always adjust the position of the graphic and surrounding text further by left-clicking on the graphic and holding the left button down,
and then moving the mouse around. You will see the shadow outline of the graphic move with you. Let go of the left button to drop the graphic
in a new place. It may take several tries to get it to look “perfect,” as the whole page of text can change around with you. Sometimes the graphic
can even jump to a new page if there is not enough room. To help it position where you want, you can adjust the size of the graphic itself by
left-clicking on it once to make it active, and then positioning your cursor on the small circle marking its top left corner. The cursor arrow will
change to a double-headed arrow line. Hold the left button down and move the cursor towards the center of the rectangle to reduce the size of
the graphic.
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E. How do I download numeric data into an Excel spreadsheet for my own further analyses?

You can download the report from the filter criteria platform or from a rendered report. To download the report from the filter criteria screen,
please click the “Download Report” button.

Report Type > Raw Data ReportType > Reportable Surveys

Reportable Surveys

Filter Options Report Criteria

Activity Group Using the available criteria on the left, please select which subset of schools you'd like to include in the report. Please note that you can include schoaols from t
or you can include institutions specifically, which allows you to create reports using the District 2 institutions, along with the University of Texas.
Carnegie Classification
Please include all schools whose...
CASE District
- Institution Name: Drexel University, Colurmbia University, Boston College, Arizona State University, American University
Educational and General Budget

Enrallment

Cancel Report Get Report Download Report
| | | |

Institutional Group
Pubilic / Private
U5 Region

U5 State

By Name Specifically

If I wanted to download a report with “All Institutions” I would simply select the whole group “By Name Specifically.” The xml spreadsheet
will be exported for use in Excel.
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You can also download the data from rendered reports. In the upper right hand corner of your rendered report is a small graphic of a diskette.

Please click the diskette to download your rendered report in Excel.

! MY SURVEYS o= REPORTS

BENCHMARKING TOOLKIT ® HELP

Report Type > Raw DataReport Type > Reportable Surveys > Raw Data Report

CASE's Basic Benchmarking Survey - DEMO ONLY - FY 2009

First, let's gather some basic descriptive information about... | Michigan State Uil Anonymous 1 Anonymous 2 Anonymous 3
For what type of organization will you be reporting datain your A complete A complete A complete A complete
answers to these questions? individual individual individual individual

campus, college,
or university

campus, college,
or university

campus, college,
or university

campus, college,
or university

If your organization is a sub-unit or affiliate of a larger Mot a sub-unit of = Mot a sub-unit of = Notasub-unitof = MNotasub-unit of

educational institution, what kind of organization is it? alarger alarger alarger alarger
organization organization organization organization

Is your institution “public” (i.e. taxpayer-funded), or “private? "Public" "Private" "Public" "Private"

What was the total budget (expenditure) of your organization in = 595,000,000 100,000,000 200,000,000

its most recently completed accounting year?

Mext, let's hear about the voluntary support your organizat... Michigan State U/ Anonymous 1 Anonymous 2 Anonymous 3

Heowe much "tatal violointane ciinnnt” did vonre arnanizatinn raica 200 000 N0 N T3 R00 0NN 120 000 N0

Important Note: The downloaded file is an xml spreadsheet. If your browser is set to “hide file extensions” you may have to add .xls to the file

name. Please set your browser to “Show file extensions.”

If you have any questions or concerns please contact the research staff at research@case.org.

For more information on the CASE Benchmarking Toolkit please visit us online at:

Anonymous 4

Acomplete
individual
campus, college,
or university

Not a sub-unit of
alarger
organization

"Private"

3,000,000,000

Anonymous 4
AN D00 OO0

Anonymous 5

Acomplete
individual
campus, college,
or university

Not a sub-unit of
alarger
organization

"Private"

250,000,000

Anonymous 5
75 QRO 00N

http://www.case.org/Samples Research and Tools/Benchmarking and Research/CASE Benchmarking Toolkit.html
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F.

Is there a short walk through / summary for running or accessing your results in the CBT?

To view and download your data:

1)
2)
3)
4)
5)
6)
7)

Click reports tab or button

Click “Raw Data Report”

Click “Multiple Institution Report”

Select your survey from those listed

Now select your filter criteria on the left hand side (you may wish to choose “By Name Specifically”)

Please select and move all institutions you wish to benchmark against into the “selected institutions” box using the arrow buttons
Hit Save

You will need to select at least 5 other institutions to run a benchmarking report. Then click save changes. Now you have your institution in line to
benchmark against your selected group (or all respondents if you like).

You now have two choices:

1) Render your report on screen (this enables you to view the data and pop-out charts) by clicking GET REPORT (charts contain medians and mean)

2) Download your data by clicking DOWNLOAD YOUR DATA

If you have downloaded your data in the UK the file extension may be missing from the download. This is because your browser is set to hide file
extensions. I recommend you change this browser setting. You can also just rename the file and type ".xIs" after the file name. Then go ahead
and open the file up in Excel. If it gives you a warning about being from a trusted source, just click allow or ok. You can now save your file as a
07 workbook, 03 workbook, or an xml file.

Once you have downloaded your data you can still view it on-screen by clicking never mind and then GET REPORT. You can also download the
rendered table in Excel by clicking the disk icon in the upper right hand corner.

Please contact CASE Research at research@case.org if you have any questions or concerns.
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